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1. 

1.3 

 - WEEE

 

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2002/96/EC governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 

organization that serves your household or the 
store at which you purchased the product.

Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 

All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

how to dispose of your old monitor and packing 
from your sales representative. 

Taking back/Recycling Information for 
Customers
Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation in national take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors, 
which recycle all materials (products and related 
packaging material) in accordance with all 
Environmental Laws and taking back program 
with the contractor company.

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit  

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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2. 

  PC
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1  Kensington
2  VGA 
3  DVI
4  
5  
6  

 PC
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19S4LA
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 OSD
OSD

OSD

 SmartPower

 OSD
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2. 

 

SmartImage 6

Photo Movie
Game

Economy Off
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2. 

 (OSD)

(OSD)?
On-Screen Display OSD

Philips LCD

OSD
   OK

OSD
OSD

Main menu Sub menu

Picture

Audio

OSD Settings

Setup

Language

Color

Input

Brightness

Contrast

Horizontal

Vertical

Transparency

OSD Time Out

Auto

V.Position

Phase

Clock

Resolution Notification

Reset

Information

English, Deutsch, Español, Ελληνική, Français, 
 Italiano, Maryar, Nederlands, Português, 
Português do Brazil, Polski, Русский, Svenska, 
Suomi, Türkçe, Čeština, Українська, , 
繁體中文, 日本語, 한국어 

Color Temperature

sRGB

User Define

VGA 
VGA

DVI(Optional)

SmartContrast

Gamma

Volume

Mute

H.Position

(19S4LA)

0~100
100

6500K

100

100

100

English

50

Off

80

Off

2.2

50

50

Off

On

No

20s

0~100

0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

On, Off

Yes, No

0~100

0~100

0~100

5000K, 6500K, 7500K,
8200K, 9300K, 11500K

Red: 0~100

Green: 0~100

Blue: 0~100

On, Off

0~100

On, Off

1.8, 2.0, 2.2, 2.4, 2.6 

0~100
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2. 

 

1280 x 1024 @ 60 Hz

1280 x 1024 @ 60 Hz

Setup

 

20
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2. 

2.3 

2. 

4. 

 
100mm x 100mm

AUDIO IN

100mm

100mm
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3. 

3. 

3.1 SmartImage

 ?
SmartImage 

Philips SmartImage 

 ?

SmartImage 

 
SmartImage  Philips 

SmartImage 

 - 

  SmartImage

   SmartImage

   Photo 
Movie Game  

Economy Off
3. SmartImage OSD 5

OK
 SmartImage  

sRGB  sRGB
   

SmartImage
 6 Photo

Movie Game
Economy Off

PDF 

 – 
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3. 

 SmartImage 

3.2 SmartContrast

 ?

 ?

SmartContrast 

 
 SmartContrast 

3.3 Philips SmartControl Premium
Phillips  SmartControl Premium 

/ RGB 

 Windows 7 
 

Philips !

 

 SmartControl Premium 

Plug-in( )
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3. 

Standard

 Standard

Adjust
Brightness Contrast

Resolution

Cancel ( )

Color
Color

RGB Black Level White 
Point Display Gamma
Gamma Calibration  
SmartImage SmartKolor

Color Calibration
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3. 

1. “Show Me”( )
2. Start( ) -  6 
3. Quick View ( ) /

Color

 - 

Start Quick View
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3. 

Previous (
)

Next ( ) 6 

File > Presets ( > )

Cancel ( )
Plug-in ( )

SmartImage

 SmartContrast  
SmartResponse

ECO Power

Options
 - 

Options ( )  
Preferences ( )

 DDC/CI Help (
) Option( )

On ( ) 
Enable Context Menu (
) Enable Context Menu (

)  
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3. 

SmartControl Premium Select Preset (
) Tune Display ( )

 
SmartControl Premium

On ( )Enable 
Task Tray ( ) Enable 
Context Menu ( )  
martControl Premium 

Help (
) Technical Support( )

Check for Update (
) About ( )  Exit ( )
Enable Task Tray

Exit

On ( ) Run 
at Startup ( )

SmartControl Premium 
 

SmartControl Premium 

 (Windows 7/Vista/XP)
 0% 

- 
Options ( ) Audio ( ) 

 DDC/CI
Help ( ) Option( )

Options>Auto Pivot ( > )

 - 
Options( ) Input( )

 DDC/
CI Help ( ) Option( )

 SmartControl Premium 

Source ( )
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3. 

 
- Plug-in ( )
Theft Deterrence
Theft Deterrence

Theft Deterrence ( )
Theft Deterrence ( )

 4  9  PIN
 PIN Accept ( )

 5
 5

Theft Deterrence ( )
 PIN Theft Deterrence ( )

Theft Deterrence ( )
PIN Options (PIN )

Theft Deterrence ( )
Theft Deterrence ( )

PIN Options (PIN )
 PIN  PIN 

Help
  - 

Help ( )  User 
Manual ( )

 DDC/CI Help ( )
Option( )

 - Help (
) Version( )

 DDC/CI
Help ( ) Option( )
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3. 

Context Sensitive menu ( )
Context Sensitive menu ( 

)  
Options>Preferences ( > )

Enable Context Menu (
)

Context Ment ( )  4 

 - “
”

 - 

 -  
SmartControl Premium 

 - Off
Office Photo  

Movie Game
Economy

 SmartControl 
Premium 

 5 

- 
 User Manual (

) 
- 

 - 
PDI

 - 

-  SmartControl 
Premium

 SmartControl Premium
Program ( )  SmartControl 

Premium  PC 

“Exit ( )”
 SmartControl Premium  

Options>Preferences ( > ) 
Run at Startup ( ) 

 
SmartControl

www.portrait.com/dtune/
phl/enu/index CmartControl
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3. 

3.4 SmartDesktop 

 SmartDesktop
SmartDesktop  SmartControl Premium 

 SmartControl Premium  
Options ( )  SmartDesktop

Align to 
partition ( ) 

Identify

 

 

“Show windows contents while dragging”(
)

 Control Panel ( )  
System ( )

Advanced system settings (
)  Vista  Win7 

 Performance ( )  
Settings ( )

 Show window contents 
while dragging ( )

 OK ( )

Vista:
Control Panel ( ) > Personalization 
( ) > Window Color and Appearance 
( ) > “Open Classic 
appearance properties for more color options 
( )” 
> “Effects ( )”  > “Show 
window contents while dragging (

)”

XP:
Properties ( ) >Appearance (

) >Effects... ( ...) > Show window 
contents while dragging (

)

Win 7:
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3. 

 
Desktop partition ( ) 

 
 Desktop Partition ( ) 

 – 

Find Windows ( ) 

– Desktop 
Partition ( )

 

 – 

– 
/

 – Desktop Partition (
) Display Tune ( )

 start( )
 Display Tune (

) 

 
 Desktop Partition ( ) 
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3. 

 
 

( )

– 

Find Windows ( ) 

 – Desktop 
Partition ( )

 – 

– 
/
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3. 

 SmartDesktop 

Full Desktop 
( )

Vertical( )

90/270 

Horizontal( )

90/270 

Vertical Triple 
( )

90  1  2 
 3 

270  3  2 
 1 

Vertical Split Left 
( )

90 1 2&3
270 1 2&3

Vertical Split Right 
( )

90  1  2  3 
270  3  1  2 

Horizontal Split Top 
( )

90  1  2  3 

270  1  2  3 
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3. 

Horizontal Split 
Bottom 
( )

90  1  2  3 

270  1  2  3 

Even Split( )
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4. 

4. 
/

TFT-LCD
LED
19" ( 48.3 cm)
5:4
0.294 x 0.294 mm
250 cd/m² 

SmartContrast 20,000,000:1
1000:1

 5ms
1280 x 1024 @ 60Hz
170°(H) / 160°(V) @ C/R > 10
1670 
56 Hz - 76 Hz
30 kHz - 83 kHz

sRGB

DVI
VGA

/ PC

1.5W x 2
19S4LA: 
19S4LS: 

OSD 

Kensington 
DDC/CI sRGB Windows 7/8/Vista/XP Mac OSX Linux

-5 / +20
-65 / +65
110 mm
90

15.2W  25W

EnergyStar 100VAC, 50Hz 115VAC, 60Hz 230VAC, 50Hz
14.3W 14.3W 14.3W
0.1W 0.1W 0.1W
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4. 

0.1W 0.1W 0.10W

* 100VAC, 50Hz 115VAC, 60Hz 230VAC, 50Hz
48.81 BTU/hr 48.81 BTU/hr 48.81BTU/hr
0.34 BTU/hr 0.34 BTU/hr 0.34 BTU/hr
0.34 BTU/hr 0.34 BTU/hr 0.34 BTU/hr

 LED /
100-240VAC 50-60Hz

(WxHxD) 404.3X417.7X193.9 mm

(WxHxD) 404.3X346.2X60.7 mm

3.20 kg
2.80 kg
4.92 kg

0   40 
-20   60
20%  80%

MTBF 30,000 

ROHS
EPEAT (www.epeat.net)

100% 
100% PVC BFR

EnergyStar

CE Mark FCC Class B SEMKO UL/cUL BSMI GOST
GS ERGO WEEE PSB C-Tick CEL
China RoHS CCC CECP ETL CU UKRAINIAN

/

 
1. EPEAT Gold  Silver  Philips ,

 www.epeat.net
 www.philips.com/support 
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4. 

4.1 

 
1280 x 1024 @ 60 Hz
1280 x 1024 @ 60 Hz

 
1280 x 1024 @ 60 Hz

(kHz) (Hz)
31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
44.77 1280x720 59.86
63.89 1280x1024 60.02
79.98 1280x1024 75.03

 
 

1280 X 1024@60Hz
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5. 

5. 
 PC  DPM 

“ ”

  LED 

 15.2W
25W

 0.1W  

- - 0.1 W

1280 x 1024
50%

250 
6500k 
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6

6. 
Congratulations!

that the manufacture, use and 

social and economic responsibility.  Every 

accredited independent test laboratory.   

Corporate Social Responsibility 
Socially responsible production - working 
conditions and labor law in manufacturing 
country

 
Energy efficiency of product and power supply. 
Energy Star compliant, where applicable 

Environmental Management System 
Manufacturer must be certified according to 
either ISO 14001 or EMAS

Minimization of Hazardous Substances 
Limits on cadmium, mercury, lead & hexavalent 
chromium including requirements for mercury-
free products, halogenated substances and 
hazardous flame retardants

Design for Recycling 
Coding of plastics for easy recycling. Limit on 
the number of different plastics used.

Product Lifetime, Product Take Back 
Minimum one-year product warranty. Minimum 
three-year availability of spare parts. Product 
takeback 

Packaging 
Limits on hazardous substances in product 
packaging. Packaging prepared for recycling

Ergonomic, User-centered design 
Visual ergonomics in products with a display. 
Adjustability for user comfort (displays, 

headsets)  Acoustic performance – protection 
against sound spikes (headsets) and fan noise 
(projectors, computers) Ergonomically designed 
keyboard (notebooks)

Electrical Safety, minimal electro-magnetic 
Emissions  Third Party Testing  
All certified product models have been tested 
in an independent, accredited laboratory.

A detailed criteria set is available for download 
at www.tcodevelopment.com, where you can 

TCO Development, the organization behind 

collaboration with scientists, experts, users 
and manufacturers. Organizations around the 

them reach their sustainable IT goals. We are 

is headquartered in Stockholm, Sweden, with 
regional presence in North America and Asia.

For more information, please visit 
ww.tcodevelopment.com

(Only for selective models)
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6. 

Lead-free Product
Lead free display promotes environmentally 
sound recovery and disposal of waste from 
electrical and electronic equipment. Toxic 
substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

EPEAT
(www.epeat.net)

The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 51 
environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.

Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 

means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity
This product is in conformity with the following 
standards 

EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of 
Information Technology Equipment).
EN55022:2010 (Radio Disturbance 
requirement of Information Technology 
Equipment).
EN55024:2010 (Immunity requirement of 
Information Technology Equipment).
EN61000-3-2:2006 +A1:2009+A2:2009 
(Limits for Harmonic Current Emission).
EN61000-3-3:2008 (Limitation of Voltage 
Fluctuation and Flicker) following provisions 
of directives applicable.
2006/95/EC (Low Voltage Directive).
2004/108/EC (EMC Directive).
2009/125/EC (ErP Directive, EC No. 
1275/2008 Implementing Directive 
for Standby and Off mode power 
consumption) and is produced by a 
manufacturing organization on ISO9000 
level.

The product also comply with the following 
standards 

ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).
GS EK1-2000:2011 (GS mark requirement).
prEN50279:1998 (Low Frequency Electric 
and Magnetic fields for Visual Display).
MPR-II (MPR:1990:8/1990:10 Low 
Frequency Electric and Magnetic fields).
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Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR® 

 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  
 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

Reorient or relocate the receiving antenna.
Increase the separation between the 
equipment and receiver.
Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.
Consult the dealer or an experienced 
radio/TV technician for help.

approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device. 

shock hazard, do not expose this appliance to 
rain or excessive moisture. 

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 

Commission Federale de la Communication 
(FCC Declaration)

 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de 
l'article 15 Des règles de la FCC. Ces 

une protection raisonnable contre les 
interférences nuisibles dans le cadre d'une 
installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  
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6. 

Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

Réorienter ou déplacer l’antenne de 
réception.
Augmenter la distance entre l’équipement 
et le récepteur.
Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.
Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.

l'approbation des services compétents 
en matière de conformité est susceptible 

équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA. 

EN 55022 Compliance (Czech Republic Only)

Notice
The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACER INGEN FOR , AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)
Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften. 

ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 

1. Reparaturen nur durch Fachpersonal 
durchgeführt werden. 

2.  nur original-Ersatzteile verwendet werden. 
3.  bei Ersatz der Bildröhre nur eine 

bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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China RoHS 
The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products produced and sold for China 
market have to meet China RoHS request.

RoHS

(Pb) (Hg) (Cd) (Cr6+) (PBB) (PBDE)

O O O O O O

X O O O O O

X O O O O O

X O O O O O

X O O O O O

*:  

O:  

X:  

“X” RoHS
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7. 

7.1 

 TFT 

TFT 

 0.0004% 

 

- + =
- + =
- + =
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7. 

 TFT 

 
 50% 

 30%

1 3
2 1
3 1 0

* >15mm
3

1 5 
2 2 
3 0

* >15mm
5 

5 

 
1. 1 2  = 1

ISO9241-307 Class-I ISO9241-307: 

3. ISO9241-307 ISO13406 (ISO) 2008-
11-13.
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7.2 
www.philips.com/support

/ CSP
Austria RTS +43 0810 000206 € 0,07 Mon to Fri : 9am - 6pm
Belgium Ecare +32 078 250851 € 0,06 Mon to Fri : 9am - 6pm
Cyperen Alman 800 92 256 Free of charge Mon to Fri : 9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff Mon to Fri : 9am - 6pm
Finland Infocare +358 09 2290 1908 Local call tariff Mon to Fri : 9am - 6pm
France Mainteq +33 082161 1658 € 0,09 Mon to Fri : 9am - 6pm
Germany RTS +49 01803 386 853 € 0,09 Mon to Fri : 9am - 6pm
Greece Alman +30 00800 3122 1223 Free of charge Mon to Fri : 9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff Mon to Fri : 8am - 5pm
Italy Anovo Italy +39 840 320 041 € 0,08 Mon to Fri : 9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff Mon to Fri : 9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0,10 Mon to Fri : 9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff Mon to Fri : 9am - 6pm
Poland MSI +48 0223491505 Local call tariff Mon to Fri : 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge Mon to Fri : 8am - 5pm
Spain Mainteq +34 902 888 785 € 0,10 Mon to Fri : 9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff Mon to Fri : 9am - 6pm
Switzerland ANOVO CH +41 02 2310 2116 Local call tariff Mon to Fri : 9am - 6pm
United Kingdom Celestica +44 0207 949 0069 Local call tariff Mon to Fri : 8am - 5pm
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/ CSP

Belarus N/A IBA +375 17 217 3386
+375 17 217 3389

Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport 420 272 188 300

Estonia N/A FUJITSU +372 6519900(General)
+372 6519972(workshop)

Georgia N/A Esabi +995 322 91 34 71

Hungary N/A +36 1 814 8080(General)
+36 1814 8565(For AOC&Philips only)

Kazakhstan N/A Classic Service I.I.c. +7 727 3097515

Latvia N/A ServiceNet LV +371 67460399
+371 27260399

Lithuania N/A UAB Servicenet +370 37 400160(general)
+370 7400088 (for Philips)

Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus N/A Service af + 375 17 284 0203
Turkey N/A Tecpro +90 212 444 4 832

Ukraine
N/A Topaz +38044 525 64 95
N/A Comel +380 5627444225

/
Brazil

Vermont
0800-7254101

Argentina 0800 3330 856

/
PCCW Limited 4008 800 008
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7

/

U.S.A. EPI - e-center (877) 835-1838

Canada EPI - e-center (800) 479-6696

APMEA 

/ ASP

Australia AGOS NETWORK 
PTY LTD 1300 360 386 Mon.~Fri. 8:00am-7:30pm

New Zealand Visual Group Ltd. 0800 657447 Mon.~Fri. 8:30am-5:30pm

Hong Kong
Macau

Firma: Smart Pixels 
Technology Ltd.

Hong Kong:
Tel: +852 2619 9639
Macau:
Tel: (853)-0800-987

Mon.~Fri. 9:00am-6:00pm
Sat. 9:00am-1:00pm

India REDINGTON INDIA 
LTD

Tel: 1 800 425 6396
SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm

Indonesia
PT. CORMIC 
SERVISINDO 
PERKASA

+62-21-4080-9086 
(kundeservice)
+62-8888-01-9086 
(kundeservice)

Mon.~Thu. 08:30-12:00; 13:00-
17:30
Fri. 08:30-11:30; 13:00-17:30

Korea Alphascan Displays, Inc 1661-5003 Mon.~Fri. 9:00am-5:30pm
Sat. 9:00am-1:00pm

Malaysia R-Logic Sdn Bhd +603 5102 3336 Mon.~Fri. 8:15am-5:00pm
Sat. 8:30am-12:30am

Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm

Singapore

Philips Electronics 
Singapore Pte Ltd 
(Philips Consumer Care 
Center)

(65) 6882 3966 Mon.~Fri. 9:00am-6:00pm
Sat. 9:00am-1:00pm

Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00

Thailand Axis Computer System 
Co., Ltd. (662) 934-5498 Mon.~Fri. 08:30am~05:30pm

South Africa Computer Repair 
Technologies 011  262 3586 Mon.~ Fri. 08:00am~05:00pm

Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00 

Vietnam
FPT Service Informatic 
Company Ltd. - Ho Chi 
Minh City Branch

+84 8 38248007
Ho Chi Minh City
+84 5113.562666
Danang City
+84 5113.562666
Can tho proviencen

Mon.~Fri. 8:00-12:00, 13:30-17:30
Sat. 8:00-12:00
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7. 

Philippines EA Global Supply 
Chain Solutions ,Inc. (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm

Armenia
Azerbaijan
Georgia
Kyrgyzstan
Tajikistan

Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00

Uzbekistan Soniko Plus Private 
Enterprise Ltd +99871 2784650 Mon.~Fri. 09:00 - 18:00

Turkmenistan Technostar Service 
Centre +(99312) 460733, 460957 Mon.~Fri. 09:00 - 18:00

Japan 03-5676-6022 Mon.~Fri. 09:00 - 18:00
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8. 

8. 

8.1 

 
Philips 

 

 LED 

 LED 

Attention

Check cable connection

AUTO
AUTO VGA-
Analog (VGA- )

 OSD 

 
AUTO  DVI-Digital 

DVI- )

 Philips 

 

 OSD “Auto ”

 OSD  Setup  
Phase/Clock /

 VGA 

 PC

 OSD “Auto ”

 OSD Setup ( )  
Phase/Clock ( / )

 VGA 

 OSD “Auto ”

 OSD Setup ( )  
Phase/Clock ( / )

 VGA 
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8. 

 OSD 

“ ” “ ” “
” “ “ “ ” “ ”

“ ” “
” “ ”

“ ” “
” “ ”

 PC 

 
 OSD “ ”

 LED “ ”

 Philips 

8.2 SmartControl Premium 

 1   PC 
 PC SmartControl 

Premium 

 PC SmartControl 
Premium

 
SmartControl Premium 

 2  SmartControl Premium 

 

 service pack 

 Windows Update /

 
Windows

 My Computer 
Properties 

-> Hardware -> Device 
Manager

Monitor ( ) “Plug 
and Play Monitor( )”

 SmartControl 
Premium

 3   SmartControl Premium 
 SmartControl Premium 
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8. 

 
SmartControl Premium

 
SmartControl Premium

 Philips 
 SmartControl 

Premium 

 4  Product Information (
)

 

DDC/CI

 
SmartControl Premium

Attention

Theft Deterrence is Enabled

 5  Theft Deterrence ( 
)  PIN

 
Philips 

8.3 

 1  
Cannot display this video mode

 
1280 x 1024 @60 Hz

 PC 

 Windows Start( )
Settings/Control Panel( / )

Control Panel ( )
Display ( ) Display ( )

“Settings( )”
“Desktop Area

” 1280 x 
1024

“Advanced Properties( )”
Refresh Rate ( ) 60 Hz

“ ”
2 3

PC 1280 x 1024 @60 Hz

 Philips LCD
 PC 

 2  LCD

 LCD 60 
Hz

75 Hz

 3   .inf  .icm 
 .inf  

.icm
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8. 

 
 User Manual ( ) 

.inf  .icm 

.inf  .icm 

 4  
 /

Windows® Control 
Panel (Windows® )
“Display properties( )”

 5  

 OK
Reset ( )

 6  LCD ?
 

 7   LCD 
 

 8  

 OSD

 OK  OSD

“ ”  Color
 OK

1. Color Temperature ( )  6 
 5000K 6500K

7500K 8200K 9300K  11500K
5000K

“ ”
11500K “

”

2. sRGB: 

)

 

 2004K
 9300K

6504K

 9   
PC  Mac 

 
 PC Mac 

 Mac 

 Philips 

 10  

 Windows 
8/7/Vista/XP/NT Mac OSX
Linux

 11  
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8. 

 
“ ”

“ ” “ ” “
“ “ ” “ ”

“
” “ ” “ ”

 

“ ” “ ”
“ ”

 12  

 
1280 x 1024 @ 60 Hz
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